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License Agreement
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Guide. You nor any other party are granted any ownership rights, copyrights, trademark rights, or any other rights whatsoever in or to 
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the Setup Guide; (d) perform or display the Setup Guide publicly; or (e) authorize others to do any of the forgoing.

What is a copyright?
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rights to: 

1.	 Reproduce the copyrighted work in copies however produced (e.g., photocopying, scanning, faxing, electronically); 

2.	 Prepare derivative works (e.g., translations, revisions, abridgements, dramatizations, video adaptation, any form in which  
	 the work may be transformed or adapted); 

3.	 Distribute copies for sale; 

4.	 Perform or display the work publicly; and 

5. 	 Authorize others to do any of the above.

What is the copyright policy of the David Allen Company?

It is the policy of the David Allen Company to reserve all copyrights to itself and to vigorously pursue any unauthorized use of its work.
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GTD®, the popular shorthand for Getting Things Done®, is the groundbreaking work-life management 
system and book1 by David Allen that transforms personal overwhelm and overload into an integrated 
system of stress-free productivity. 

Sophisticated without being confining, the subtle effectiveness of GTD lies in its radically common sense 
notion that with a complete and current inventory of all your commitments, organized and reviewed  
in a systematic way, you can focus clearly, view your world from optimal angles and make trusted  
choices about what to do (and not do) at any moment. GTD embodies an easy, step-by-step and highly 
efficient method for achieving this relaxed, productive state. It includes:

•	 Capturing anything and everything that has your attention 

•	 Defining actionable things discretely into outcomes and concrete next steps 

•	 Organizing reminders and information in the most streamlined way, in appropriate categories, based on how 
and when you need to access them 

•	 Keeping current and “on your game” by regularly reviewing the six horizons of your commitments (purpose, 
vision, goals, areas of focus, projects, and actions) 

•	 Instilling the trust that what you are doing is the best thing for you to be doing in any given moment

Getting the most out of Outlook®

For many of our clients, Microsoft Outlook is a logical choice for organizing their project and action 
reminders, especially if they already use Outlook for email and calendaring. This guide will walk you 
through applying the best practices of GTD to Outlook 2013. Consider these suggestions a starting  
point, customizable to fit your own needs and use of Outlook.  

Outlook has features built-in to enable the structuring of a very powerful personal workflow system.  
The trick is to know which features to ignore and which to use, and how to customize that usage  
to fit with the best practices of Getting Things Done. 

The Outlook Task function can be customized to be a simple but powerful list manager. The Outlook Notes 
section can be turbo-charged with some very useful reference material and checklists. Also, there are 
some simple things to do to manage email and the calendar that enhance their functionality and tie the 
whole inventory of your work together into a seamless and integrated dashboard for your workflow. 

1Getting Things Done: the Art of Stress-Free Productivity; Viking, New York; 2001, hardback or paperback. Available from booksellers or at www.gettingthingsdone.com

Introduction
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  2The Getting Things Done book has many helpful tips about the Weekly Review, including a checklist to follow.

The best practices of Getting Things Done
In order to understand our specific recommendations for Outlook setup and usage and to maximize its 
potential in practice, it’s important to clarify some simple but powerful productivity behaviors. These are 
fundamental to the success of the system.

1.  Don’t leave anything in your head or in unprocessed stacks
If your system contains only partial information, it won’t give you the payoff of a system, and you won’t  
be motivated to maintain it. For example, if your “Calls” list doesn’t have every single call you need to 
make, your head will still have to keep remembering and reminding you about the rest of them. Trying  
to keep only some of them in Outlook will be too much work for the minimal benefit you’ll gain.

2.  Decide the next physical action
If you don’t determine the very next action needed on a task or project or an email, you won’t know where 
to park the reminder, and the pressure of still needing to make a decision will cause you to avoid engaging 
with your lists. 

3.  Review and update the contents of the whole system regularly
A system is only as trustworthy and beneficial as it is current, consistent and complete. The more the 
system can be kept up to date as you go along, the more “alive” and supportive it will be to allow your 
mind to focus on the work at hand. The world will probably come at you faster than you can keep it totally 
processed and organized, but you can’t let it slip too long before you catch up. The reminders of projects 
and actionable items must be cleaned up and refreshed at least every seven days, in a process we call  
the “GTD Weekly Review®”.2

The need for simple lists
Once you have appropriately processed your “stuff”, simple lists will store most of your reminders and 
reference information. These can be “flat” lists—not tied or related to other things, nor sorted by priority  
or urgency—just lists. You need a list of projects, a list of all the calls you need to make, a list of all 
the things you are waiting for to come back from other people, etc. You may also want lists of your key 
objectives for the year, books you might want to read, and all the things you might want to pack whenever 
you take a trip. The Outlook Tasks section can be a terrific list manager for your actionable items and the 
Outlook Notes area can serve as a very functional catalog of checklists and reference material. 

Introduction
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Making your lists portable
Another key success factor to using Outlook for personal management is having an easy way to publish the 
lists into some portable format and the behavior of actually doing that when needed. Any personal organizer 
will function at a much higher level when it contains everything that might be needed for a reminder anywhere 
(vs. some at the office, some at home, some in your briefcase, some in your head, etc.) It will need to contain 
a list of errands you need to run when you’re out and about, things to talk with your spouse about when you’re 
with them, and things to do at home when you have some time in that environment. If you subliminally know 
that your lists may not be with you when you might use them (such as having your Calls list available whenever 
you have free time and a phone), you won’t be motivated to keep them populated and current. 

There are two ways to make your lists portable:

1.  Synchronize to a handheld 
You can set up Outlook to synchronize with most of the popular handheld/mobile devices, to take your 
system on-the-go. Many devices will support the syncing of Outlook Email, Calendar, Tasks, and Notes  
and will display in the built-in applications on the handheld device or by purchasing add-on applications  
or syncing services to enable the syncing to work.

With the many unknown variables involved with syncing (server settings, firewalls, device features and 
limitations, email client, etc.) we do not include syncing information in our Setup Guides.

We recommend doing an Internet search for the latest instructions and popular approaches for syncing 
Outlook to your device. Try search phrases such as “syncing Outlook to iPhone®” or “syncing Outlook  
to Android®.” You’ll find a wealth of helpful articles to equip you with the best resources. 

Before choosing a handheld device, we suggest checking with your IT department first, if you have one,  
to see what device they will support and will allow to connect to your corporate data. Whatever system  
you end up using, master the basics early on, so that you are on “automatic”, i.e., you’re just using it,  
not thinking about how to use it, and not trusting your head more than the tool. 

2.  Print your lists into hard copy
Instead of using a handheld, some people choose to print out appropriate action-reminder lists into hard 
copy, including their calendar, to carry with them when they leave their computer. They then hand-edit those 
lists as they move around, in meetings, at home, or traveling, updating Outlook when they are back at their 
workstations. This can work fine, and in some cases, because of the additional visibility and note-adding 
capability of paper lists, better than a digital version. Outlook Tasks and Calendar can be easily printed  
using the File > Print menu.

Introduction
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Speed up your processing
The ease of making entries as you go, as things occur to you, is essential to using Outlook for action 
management. The system should work almost as quickly as you think, or it won’t hold up to keep you 
current. Subliminal resistance to your data entry process usually creates a barrier for using any digital  
tool as a total system. The faster you are at the keyboard, the more you will be able to use Outlook  
as a highly leveraged personal productivity device. 

Studies show you’ll be four times faster using speed keys than reaching for your mouse. If you aren’t  
using them already, learn the speed keys for the Windows® and Outlook functions you use the most. 

In any Windows application, the speed keys for most menu functions within an application can be found 
through the Alt key.

 

Standard Windows speed key combinations 

<Ctrl> a – Select the whole document 
<Ctrl> c – Copy whatever is selected to clipboard 
<Ctrl> x – Cut whatever is selected to the clipboard 
<Ctrl> v – Paste what’s in the clipboard to the cursor location 
<Ctrl> p – Print 
<Ctrl> z – Undo 
<Ctrl> y – Redo
<Alt> <Tab> – Switch between open Windows applications

Introduction
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Outlook-specific speed keys 

<Ctrl+Shift> k – Creates a new task 
<Ctrl+Shift> a – Creates a new appointment
<Ctrl+Shift> n – Creates a new note 
<Ctrl+Shift> m – Creates a new email msg 
<Ctrl+Shift> e – Creates a new email folder 
<Ctrl+Shift> v – Moves an email message
<Ctrl+Shift> h – Creates a new MS Office file
<Ctrl+Shift> c – Creates a new contact 
<Ctrl> n – Creates new entry in current mode
<Alt>  h+g – Categorizes open task

<Ctrl> 1 – Switch to mail 
<Ctrl> 2 – Switch to calendar 
<Ctrl> 3 – Switch to contacts 
<Ctrl> 4 – Switch to tasks 
<Ctrl> 5 – Switch to notes 
<Ctrl> 6 – Switch to folder list 
<Ctrl> e – Go to the search box
<Ctrl> r – Reply to open message
<Alt>  s – Send or save

Note: these shortcuts are also posted in the back of this guide.

The Navigation Bar in the bottom left corner of Outlook gives you quick and easy access to your Email, 
Calendar, Contacts, and Tasks.

You can edit what is shown in the Bar by clicking the elipses icon (. . .) and selecting Navigation Options. 
You can change the order of how the icons are displayed by left-mouse clicking on an icon and dragging  
it to a new position. 

To view Calendar and Tasks from within your other views in Outlook, be sure the To-Do Bar is selected 
within each view. For example, from within the Email view, Select View > To-Do Bar > check off Calendar 
and Tasks. In the Calendar view, you would only need to check off Tasks. In the Tasks view, you would only 
need to check off Calendar. You’ll need to make these To-Do Bar changes to each different view. 

Introduction
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How’s your typing speed? 
We highly recommend that you get up to a typing speed of at least 50 words per minute. If you are not  
there yet, we strongly suggest you install and practice with a good software typing tutor. Your keyboard  
is at least as important as your phone as a communication device (with yourself as well as with others).  
Your computer can be a strategic “think station” and especially so when there is little or no effort  
in getting a thought into it. Increasing your ease and speed with your input device may have more  
payoffs than you think.

Introduction
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Using the Tasks function as a projects and actions list manager works extremely well, if you simplify the  
View and customize your Categories. You can get to the Tasks section by clicking on the Tasks icon   
in the bottom left Navigation Bar, or using the shortcut keys <Ctrl> 4. 

In Outlook 2007, Microsoft introduced the idea of the To-Do bar, which is available throughout Outlook. 
While similar to Tasks, there are some key differences between Task and To-Do items.

A “task” is an item that you create in Outlook Tasks. A To-Do item is any Outlook item, such as a task,  
an email message, an appointment or a contact, that has been flagged for follow-up. By default, all tasks 
are automatically flagged for follow-up when they are created, even if they have no start date or due date. 
Therefore, whenever you create a task, or flag an email message, appointment or a contact, a to-do item 
is created automatically. 

Since GTD does not rely on using “follow-up flags” to determine your priorities (we suggest a trusted 
inventory of your projects and actions that you review regularly will be the best intuitive measure about 
what to do), we will be working primarily with the Tasks view in Tasks, not the “To-Do” view for your Action 
lists. Since Tasks will automatically appear in the To-Do bar, we will be using the “To-Do Bar” as a useful 
way to work with your Action items from the Inbox and Calendar views, which will be discussed in more 
detail later in this guide.

When you close Outlook, the default view when you launch Tasks again will be “To-Do List”.  
We recommend changing the default to the Tasks view instead. Here’s how to do that:

Go to File > Options > Advanced 
Browse to change Outlook start and exit to Tasks 
Click OK to save your changes

Using Outlook Tasks
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New definitions of “Category” and “Task”
Using our method, “Categories” become list titles and “Tasks” are all list items. In other words, the 
Categories will represent the various contexts (such as “Projects”, “Calls”, “Home”, etc.), and the “New 
Task” dialog will be the form to enter anything that goes on any of those lists. Assigning a category to a 
task will organize it onto your lists. The end-result is a powerful action list manager, with all of your work 
organized and tracked into a logical, intuitive and trusted system. An example of Outlook Tasks, organized 
as a GTD list manager:

One-time setup instructions
(Allow approximately 15 minutes to complete this setup)

You may find it easier to print pages 11-19 of this guide to have on hand while you make the 
following view and category changes in Outlook, rather than having to toggle back and forth.

Clean up and simplify your Task view
1.  In the top left corner of Outlook Tasks, choose Tasks instead of To-Do List. Click on Simple List under 
the Home tab.

Using Outlook Tasks
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2.  Clean up old Tasks. Get rid of any outdated entries currently in Tasks. You can do this by either deleting 
or marking items complete. This will ensure that you have a fresh start to Tasks.

Additional tips for cleaning up old tasks:

A.  Print out your current tasks view in hard copy and toss it into your hard copy Inbox to reprocess 
later into your new system. Then, select all entries <Ctrl a>, and Delete <Ctrl d>.
						      or
B.  Leave the entries you have in there, but keep them uncategorized (no Category assigned  
to them). You can do this by collapsing the list down to only categories, then select all the  
categories, right-click on the selected list, select “Categorize”, and “Clear All Categories”. 

3.  In the View tab, change to Categories under Arrangement. Make sure you are still in Simple List 
under Home tab. 

4.  Change the Columns for your Tasks view. Click View > View Settings. 
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This window will display with the default setting for Simple List:
                   
 

Click on the Columns button. Use the Add and Remove buttons to set up the “Show these columns  
in this order” column.

•	 Add: Notes and Attachment from the left column to the right by selecting each one and clicking Add  
to move it to the right. Double clicking on the field name also works.

•	 Remove: Flag Status by selecting it and clicking Remove. 

Move the columns up or down to match the order in the screen shot below. You can do this by using the 
Move Up/Move Down buttons or clicking on a column name and dragging it with your mouse to the new 
location. We prefer Complete at the bottom of this list (which will be the far right in your Outlook view) 
because it won’t be as easy to click in error. Click OK when done. 

Using Outlook Tasks



GTD and Outlook 2013   11© 1998, 2002, 2006, 2008, 2010, 2014  David Allen Company.  All rights reserved.  www.gettingthingsdone.com

The final Columns view will look like this:

5.  Group your lists by category. Click the Group By button.

 

Using Outlook Tasks



GTD and Outlook 2013   12© 1998, 2002, 2006, 2008, 2010, 2014  David Allen Company.  All rights reserved.  www.gettingthingsdone.com

Be sure Categories, Ascending is set, which it should be by default. This will sort your task categories 
(which we are using as “lists”) into distinct groups.

Some users like to have Outlook remember the way they last viewed their lists, which is particularly helpful 
for seeing a condensed view of all of your lists. On the bottom of the Group By dialog box, confirm the 
expand/collapse setting is As last viewed. 

Click OK when done.
 

6.  Sort within groups by Subject. Click the Sort button.
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We recommend sorting by Subject, so that Tasks that begin with the same action verb group together 
in the lists (such as all actions that start with a keyword such as “email” or person’s name, or a project 
keyword). You can always come back to change this setting later once you’ve experimented with what  
will work best for you.

Click OK when done.

7.  Filter completed items. By default, Outlook keeps all items marked complete on your active  
By Category list. You can imagine how unwieldy your lists would become if you’re using Tasks regularly.  
We recommend creating a filter so that completed items go to the Completed Tasks view instead. They  
are not deleted or removed from Outlook, they just go to a different view where they can easily be retrieved. 

Click on the Filter button.

 

Click on the Advanced tab. Click on the Field button and select Frequently-used fields > Complete.

Using Outlook Tasks



GTD and Outlook 2013   14© 1998, 2002, 2006, 2008, 2010, 2014  David Allen Company.  All rights reserved.  www.gettingthingsdone.com

As soon as you click on Complete, you will be returned to the previous window, and Equals and No will  
be automatically filled in for you. Click Add to List.

Click OK when done.

The final setting you may wish to change is the font size in Tasks. Click on the Other Settings tab  
to increase the font size of your Column Font and Row Font. Click OK when done.

After all of these changes, your final view should look like this:

 

These new changes will only apply to the “Simple List” view, which is the view we recommend day-to-day.  
If you change views to others such as “Detailed” or “Prioritized”, you will be seeing the default Outlook settings.
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Customize your Categories to work as lists
8. To customize your Categories, open a New Task dialog (Click “New Task” button in the top left corner  
of Tasks under the Home tab or use the shortcut <Ctrl+Shift> k ). Select the “Categorize” button in the 
Tasks window. Select “All categories” to edit the list of categories:

Alternate method for customizing Categories: If you have already created Tasks, you can click  
on a Task in the Tasks list and the Categorize button in the ribbon should become enabled. It will remain 
gray if you do not have a Task selected and you will need to get to the Categories list through a new  
Task, as described above, instead.

Note: IMAP email users may find that the Categorize button appears intermittently or behaves differently 
than the instructions describe throughout this Guide. This is a known issue with IMAP and Outlook. Please 
contact Microsoft Support or your IT department for further information on this.
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9. Click the New button and add each of your desired list names as a new category or use the existing 
categories and Rename them. In this same dialog box you can select a color for each category and  
a unique shortcut key if you want. Click OK when done. 

A suggested set of GTD categories to get started is:

Don’t be surprised if you do not see the categories you just created in the main view of Tasks. They will 
only appear when you have a Task assigned to each category.  

Sorting Trick  
Adding a period before Projects will sort this category to the top of your lists. Adding the @ symbol 
before your context-related action lists will group all of those together in your Categories view. 

Congratulations! Your Task list setup is now complete.

.PROJECTS 
@AGENDAS
@ANYWHERE
@CALLS 
@COMPUTER

@ERRANDS
@HOME 
@OFFICE
@WAITING FOR
SOMEDAY MAYBE
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The best categories to start with 
If you are familiar with our methodology, you will recognize the suggested categories as the most common 
context lists we recommend for managing your actionable items. Here is a brief description of each of the 
contexts, along with some best practices: 

The action lists 
To move things forward, you must decide the next action required. If you don’t do it in the moment  
or delegate the action to someone else, you need to keep track of it as a reminder for yourself to take 
action later. The best practice for organizing these reminders is to sort them by the critical context  
(i.e., the categories you just created) needed for the action. Does it require a phone? A computer? Do 
you have to be at home to do it? Do you need to be “out and about” doing errands? Our recommended 
categories are the most common contexts, and have proven to work well for most people who have 
implemented GTD. 

@Agendas 
This category lists the separate people you will be communicating with in real time (face to face or on the 
phone) and meetings coming toward you, for which you are collecting things to talk about when you are 
there, and perhaps to place on an agenda beforehand. 

Using the Task dialog, create a separate Task for each person you interact with regularly (boss, spouse, 
assistant, direct reports, consultants, coaches, team meetings, etc.) with the name in the “Subject” line. 
Within the Task, the notes box is a great place for collecting the separate agenda items or talking points  
to go over with them the next time you meet in person or on the phone. 

Many times the next action on a project is to talk to someone when you are with them, and creating a Task 
specific to this person provides a perfect “parking lot” for your agenda items until they are communicated.  
You will need to select and delete these items in the Notes field when they are no longer current. 
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Lists like these are very handy to keep with you at all times, in case you intersect with these people or think 
of something to talk to them about ad hoc. It is also easy to print out a single list if you want to walk into the 
meeting with hard copy for note taking. 

You could easily have fifteen or twenty people and meetings that you are tracking this way—your direct 
reports, your boss, your assistant, your spouse, the weekly staff meeting, the monthly board meeting, etc. 

If you have one very key person in your world, with whom you are constantly in touch about many different 
things, it might make sense to create another Task category for just that person’s agenda items. In other 
words, if your boss is Jenn, and much of your job consists of back and forth communications with her, 
consider creating an @Jenn category. Then you can enter items to talk with her about as separate Tasks, 
categorized as @Jenn, just like @Calls or @Computer. 

Be careful though, because if you start to create more than one or two people as categories, you will 
undermine the simplicity of your action lists in Tasks. One or two key contact people would work, but  
group the rest under the @Agendas category (with a person as a Task, and agenda notes underneath  
or each entry starting with a person’s name in the subject to group them together) to keep it functional. 

This will be much easier to grasp by actually going ahead and setting some of them up right now—i.e., 
create separate Tasks for each person you know you might have some things to go over with, and each 
meeting coming toward you for which you are likely to have some agendas. Assign each to the @Agendas 
category. Then think of some of those topics and things to cover, and insert them underneath the 
appropriate person or meeting in the Notes section. 

@Anywhere 
An action that can be accomplished without any restriction about where it’s done would go on this list. 
Typical examples would be “Draft ideas re: family vacation” (if you like doing that by hand with pen and 
paper instead of at the computer) or “Do a mindmap on new team structure”. 
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@Calls 
Place reminders of calls you need to make in this category, if they can be made from any phone. If you are 
highly mobile, take the time to type or cut and paste the phone number on the Subject line as well. Having 
the number already on your @Call list on your handheld makes it a lot easier to make the call when you are 
moving around than having to look each one of them up. 

 

Sophisticated spin on critical actions  
Some professionals have literally dozens of calls on this list at any one time, and a few find it useful 
to sort them to make it easier to scan critical actions on the run. Here are some options: 

•	 Create more than one Category of calls, e.g., @Calls-Clients, @Calls-Company, @Calls-Personal. 

•	 Start the Subject of the most important/urgent calls with a prefix like “@”. If your Tasks are being sorted 
alphabetically, it throws those to the top of the list automatically. 

•	 Create a code for the time zone of the person to call, so all your international calls are grouped together for 
reaching people during those unique hours. 

The @Calls list(s) can be effectively utilized with support staff that has access to your Tasks on the computer. 
If you arrange the proper protocols, they can leave phone message tasks directly into your version of Outlook. 
When you synch Outlook to your handheld, the list of calls (with relevant number and data) are ready and 
waiting, having been automatically added to your @Calls list. You could also create an “@incoming calls” 
category, to reserve the decision-making about what to do about them for yourself. 

@Computer 
If the action requires the computer, place it here. Emails to send, documents to edit or draft, spreadsheets 
to develop, websites to visit, data to review, etc. This list then comes into play whenever you are at your 
computer(s) with any discretionary time. Even if you only have a computer in the office, it’s still convenient  
to have this list separate from your @Office list of things to do, because you wouldn’t need to look at this  
list when the server is down or you are looking for non-computer things to do.

Also, when you are in “computer mode”, it is sometimes nice to just crank through all the computer stuff  
you need to deal with, in one view.
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If you carry a laptop and are frequently in situations where you can work on the computer but aren’t 
connected to your server or the Web, you might consider creating a separate @Web or @Online category. 
The regular @Computer list would hold anything you could do, whether or not you were connected to the 
Internet, and the @Web list would have everything that required a connection. This is handy because  
on a plane you don’t have to keep rethinking which things you can and can’t do on your laptop from your  
@Computer list, and when you get to a good connection at a hotel or in your office, you can work through 
the @Web list while you are able. Given the abundance of email most people send and receive these days, 
many people also find an @Email list to be useful, for those Tasks that require the Outlook Mail.

@Errands 
This holds reminders of things that you need to do when you are “out and about”—stop by the bank,  
take something to the tailor, buy something at a store, etc. If you are likely to think of more than one thing  
to do or get at one of those locations (like the hardware store), make “Hardware store” the task Subject  
and put your running list of things to get/do there in the Notes field below. 

If you are a regular road warrior you might consider having two errands lists—one for things you could  
do anywhere, in any city, and one for errands that have to be run where you live. 

@Home 
This list is for next actions that have to be done in your home environment. Gather tax receipts, repair the 
cabinet door, clean up the tool shed, etc. It would also hold reminders of calls that you have to make, if you 
have to be at home to make the call. 
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@Office 
These are the next actions that require you being at your office. It could be calls that you have to make from 
your desk because of the materials you need for the call. Purge your files, review information stored in your 
office, scan some documents, and look something up in the corporate library would be examples of the kind 
of items you would want to have on this list. 

@Waiting For 
This list keeps track of all the actions, projects, and deliverables that you want to happen but which are 
someone else’s responsibility. It could be something you’ve ordered that hasn’t come yet, something you’ve 
handed off to your assistant for which you’re waiting on a response, or something your boss is supposed  
to be finding out before you can move forward on a key project. 

The Waiting For should be reviewed as necessary (at least in the Weekly Review), triggering appropriate 
actions on your part to follow up, light a fire, or just check the status. 

 

Some tips for your “Waiting For” items: 

•	 Start the Subject line with the name or initials of the person or party who’s got the action. Then (if you are sorting 
alphabetically) it will group all the Waiting For items from one source together on the list. When you have meetings 
with your direct reports, you will want to review the outstanding items on their plate to ensure a proper updating 
conversation, before things become overdue. 

•	 Include the date of the handoff in the Subject line. This is critical information for later, when you want to know  
how long you’ve been waiting and when it’s appropriate to follow-up.

•	 If you have an @Agenda list for a particular person, you do not need to track items for that person in both  
a Waiting For and Agenda list. One trusted place should suffice.
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.Projects 
This category should hold the list of the normally 30 to 100 active outcomes you could have on your plate 
at any point in time that require more than one action to complete. “Implement new performance review 
process”, “Hire VP Marketing”, and “Replace tires on the car” would be examples. This should be reviewed 
in detail at least weekly, generating the next kick-start actions to be listed on your @Action lists. You create 
and maintain it the same way that you have created your other “@” lists, but it needs a somewhat different 
and more elevated focus. 

In Outlook, projects are also entered as a Tasks area, just like items that go on to the Action lists. It’s the 
category that sorts the Task onto the appropriate list. Your projects list could look like this:

By the way, having a “Get GTD Up & Running” project can be a great project to consider if you are just 
getting started with GTD. Capture everything you could do to reach that successful outcome as project  
notes and create Next Actions for yourself to do, as you can take them on.

This Projects list is the most important list to establish, maintain, and review. It is the lynchpin of the Weekly  
Review, and provides the cornerstone for managing your day-to-day operational life. Using it to regularly 
generate all your next actions to populate your @Action lists relieves the pressure of incessantly thinking 
about what you need to be thinking about. The Notes section within each project is a perfect place to jot 
simple thoughts about the project, simple bulleted-list components, etc.
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Tip for attaching emails into existing Tasks and Calendar entries
Many times, you will already have a task or calendar entry created and it would be useful  
to add information to that existing entry. For example, you may have emails and file attachments  
that are useful to store in the note field of your project with your other plans, notes, and ideas  
for that project.

To add an email to an existing entry, open the Calendar or Task item and click on the Insert tab. You will 
see buttons for attaching files, items (emails) and hyperlinks and more.

Someday Maybe 
These are the things you might want to do at some point in the future, but with no commitment to move  
on it at present. “Take a watercolor class”, “Get an MBA”, “Learn Italian”, “Upgrade billing system” could  
be examples. When you have done a thorough inventory of all your projects, some of them might need  
to be shuttled to this category, to await action until you have a more appropriate window. 

Customizing your categories 
The categories we have suggested should serve as a starting point. Some people find they don’t need  
an @Computer and @Office as separate lists, if they only have a computer at work. Some executives find 
a Projects-Delegated category useful as a high-level “waiting for” list, and executive support staff often can 
use a category “Meetings to Schedule”. 

Linking projects to actions
As you’ve seen up until now, the primary method we recommend for sorting your next actions is by 
context, not by project, which can initially seem awkward. Many people are used to having multiple files, 
piles, notepads, documents and spreadsheets related to a project, with next actions for the project buried 
amongst all of that information. Next Action lists don’t replace project plans, we would just call that data 
“project support,” and in our experience, it rarely works to have current next actions buried among project 
support for day-to-day action management. Think of the last time you had 20 minutes free and decided 
to work on a key project. How easy was it to dig through your project support to find the immediate next 
actions based on the tools, people and places available to you in the moment? Probably more repelling 
than attractive for you, especially if you knew there was still thinking to do from the project support.

When your next actions are already defined and sorted by context, you can move more quickly, more easily 
and more in sync with how you are naturally choosing what to do first—by context. Then project support 
remains the parking lot for actions that are incubated for future action.
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The GTD Weekly Review ties it all together
Rest assured, the Weekly Review is what ties the whole thing together, ensuring that you have actions  
on all the active parts of your projects on a consistent basis, largely based on those project support 
materials, so you can trust that what you are choosing from your Action lists is current. See the  
Getting Things Done book for a Weekly Review checklist.

Setting up a simple keyword system 
However, we recognize that some people want a simple way to tie some of their projects to the related  
next actions that are on the context lists, for a quick overview of the project’s progress.

A way to do this, if you’ve got the discipline, is to include a unique keyword in every entry related to that 
project, either in the subject line or body of the entry. Outlook search (Ctrl+e) is fantastic for giving you  
a quick view of items that include that keyword. An example of searching using the keyword “budget”  
is demonstrated on the next page. (Click the “X” in the search window to return to full view of Tasks.)

Keeping the system simple
It is possible to create a category for each project, and then double categorize actions to both the context 
list and the project category. For example, “Check online for passport renewal application for Italy trip” 
could be categorized as @Computer and @Italy Trip. That would give you the best of both worlds (actions 
grouped by their project and by their context). 

But in reality, if that were a consistent behavior (doubtful because of the extra work) you would have  
an outrageous and unwieldy number of categories in Tasks (one for each project plus the context lists).  
If you really think you need some digital tie between actions and their projects, try the keyword search trick.

It’s tempting for some people to create their initial system with a complex set of lists, criteria, sorting tricks 
and cross-referencing. If you have a solid understanding of the GTD and Outlook basics down, by all means 
experiment with a more customized setup. Be careful not to overcomplicate the system to a point where 
you can only maintain it when you are at your peak of mental clarity. It’s too easy to be out of that mindset 
and have the whole system fall apart. Your list manager should be complex enough to manage your 
workflow, but simple enough that if you were sick in bed with the flu you could still easily maintain it.
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Marking entries private
Some people feel more comfortable putting personal information into Outlook if they know they can mark 
the entry private. While your IT group can see anything on your company PC, the Private feature typically 
blocks colleagues from seeing details about your entries if you click the “Private” button in a Calendar or  
Task item. We recommend checking your privacy settings carefully, before entrusting that key information 
will be hidden by this feature.

Using Due Dates
All overdue Task items will appear until you complete the item or change the due date. We recommend 
using due dates judiciously. A quick way to erode trust in your system is to create a pattern of false due 
dates, where you are constantly questioning what’s a real versus made up due date, as well as spending 
your valuable time changing dates on overdue Tasks you thought you would get to.

How to create a new entry in Tasks:
Click the New Task button in the top left corner of the ribbon in the Tasks view.

Enter the description for Next Action, Project, or Someday Maybe in the Subject field.

Click the Categorize button and select a category (or in GTD terms, a “list”) to assign the entry.
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How to create a Task using shortcut keys:
<Ctrl+Shift> k opens a new Task
Type the description for your Task in the Subject field
<Alt> h + g opens category list (or use your custom  
category shortcut, if you created one)
<Arrow keys> bring you to the desired category 
<Space bar> selects the category
<Alt> s saves the entry

Note: IMAP email users may find that the Categorize button appears intermittently or behaves differently 
than the instructions describe throughout this Guide. This is a known issue with IMAP and Outlook. Please 
contact Microsoft Support or your IT department for further information on this.

Working with Completed Tasks
When you check a task off as complete, it is not deleted or removed from Outlook, it will simply go to  
a different view in Outlook Tasks called “Completed Tasks”. You will see your completed Tasks as a view 
option under the Home tab. Click Simple List to return to the normal view of Tasks.

 

If you ever check an item off as complete by mistake, go to Completed Tasks, find the Task, and simply 
uncheck the Complete column to move it back to your Simple List.

We hope this has given you a good overview of the Tasks functionality. Simplifying the view and customizing 
the categories can make it a very powerful list manager. Coupled with the Calendar, you will have a solid 
foundation for managing your workflow in Outlook.
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The best practices we recommend with the Outlook calendar include using it for three (and only three!) 
kinds of items: time-specific actions, day-specific actions, and day-specific information. The day page  
will represent the “hard landscape” for your day and will provide a trusted foundation at a glance for 
moment-to-moment orientation about “what’s next?” 

Time-specific actions 
Appointments are a straightforward matter. No mystery here. Those belong on your calendar because they 
need to happen on a specific day and time.

 

Day-specific actions 
Often there will be things that need to happen sometime during the day, but not at a specific time. These 
need to be tracked in a place that you will notice as soon as you have any time when you’re not scheduled. 
Examples would be: 

•	 A call you have to make before you leave for the day 

•	 Something that you have to finish and submit or mail by the end of the day 

•	 An agenda you must cover with someone before they leave the office 

 

You will undoubtedly make commitments like this: “José, I’ll call you sometime Monday about that.”  
(Any time Monday would be fine, but it can’t hold over until Tuesday.) And many times you will be working 
on something in the morning, and get a request or have something show up that must be fulfilled before  
the sun goes down, but you can’t stop doing what you’re doing at the moment. 
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Make it an All day event at the top of your daily calendar page, which Outlook considers free time:

 

Just click on the date bar at the top of the page and fill in the subject line with the action required, Save  
and Close. It will show up as a grayed bar at the top of your calendar page. These reminders should 
represent the same kind of commitment as your appointments. As soon as you have any open window  
at all, you should try to complete these before anything else. 

We have worked with very senior professionals whose days are so filled with these intensely short-turnaround 
actions required, they often wind up with ten to twenty of these “got-to’s” at the top of their daily calendar. 
The good news is that they have it all in one place, and it allows for a much more controlled overview  
of the game while all the action is going on. (Some executive assistants have found it very useful to put 
their boss’s name as one of those items, with a running attached note with all the agendas they have  
to cover with him or her before they escape the office at the end of the day.) 

Sometimes an action item on one of your Task lists will age to the point where it must now be done  
on, or by, a specific day coming up on your calendar. A useful feature in Outlook is to drag and drop  
that item from Tasks (or the To-do bar) over to the Calendar, either as a timed or All day event.

 

If the appointments and day-specific actions can be trusted to be the complete picture, there are many 
times there is truly no need to review any other lists or options of actions—the day is more than filled  
with those elements of the “hard landscape”. It will also be quite reassuring to you to be able to trust  
that if something would die if it weren’t done, it would be right there on the calendar. 
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Day-specific information
The third type of entry that should make it onto your calendar is information that you want to know or be 
reminded of that day—not necessarily something to do. This should also be inserted as an “event” bar at 
the top of the page (sharing space with the day-specific actions), or attached as a note to the appointment  
it may refer to.

Things you might attach in the note field of a particular appointment:

•	 Locations of and directions to meetings 

•	 Reminders of things to take to meetings happening on that day

•	 Reservation and confirmation numbers for events happening that day

Things you might create as an All day event:
Key events of interest happening that day: 

•	 Things that might disrupt the work environment (server shut-downs, office moves, etc.) 

•	 External events to be aware of (marathons, elections, heads of state visits, etc.) 

•	 Things you’re not committed to, but which you might want to participate in (TV specials, cultural  
or social events, organization events, etc.) 

•	 Activities of other significant people of interest to you (kids, spouses, bosses, assistants  
and staff vacations, extracurricular activities, etc.) 

“Tickler” information, such as a prospective client who asked you to call back “after next week”  
or a reminder to look into or consider something on a certain date.

Critical deadlines, such as: 

•	 Tickets or paper needed by that date 

•	 Critical advance notice of deadlines (“two days until budget due”) 

How to create a Calendar entry using shortcut keys:
<Ctrl+Shift> a opens a new appointment 
Type the description for your appointment in the Subject field
<Tab> key moves through the date and time fields until you reach All day event box
<Space bar> puts a checkmark in All day event box
<Alt> s saves the entry
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Putting the Calendar and Tasks together functionally
The combination of your Calendar and Task lists in one view will give you the flexibility to move between 
those key views throughout your day. To have your Tasks appear in the right panel, select View, To-Do Bar. 
Check off Tasks:

Similar to the one-time setup instructions you went through in Tasks (pages 9-16), there are a few simple 
view one-time changes to make in the To-Do Bar as well.

1.  Right-click on the words Arrange By above the Tasks in To-Do Bar and select Categories.
2.  Right-click on the words Arrange By again and select View Settings.

3.  Click on Columns button. Under the Columns window:

•	 Add: Complete field from the left column to the right by selecting it and clicking Add to move it to the right. 
Double clicking on the field name also works.

•	 Remove: Remove Header Status, Flag Status, Start Date, Reminder time, In Folder, Categories, Reminder 
and Outlook Data File columns from the right by selecting each one and clicking Remove. 
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There are no other changes you should need to make to the view. Click OK when done. Your final view 
should look like this:

Reviewing your action choices:
Check time-specific actions for today
Check the day-specific actions and information for today
Check what else can be done from your action lists, whenever you have the chance
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The fundamental success factor: operate from zero base
The master key for managing email is the hardest habit for many to change—working from a regularly 
empty Inbox. It takes less psychic effort to operate from a zero base than to leave anything sitting 
in the Inbox. That doesn’t mean that the Inbox in email is kept at zero—just that it gets there on some 
regular basis (at least once a week in the Weekly Review). The problem is that most people do not have  
a system for managing their emails beyond the Inbox area, so if they can’t move on or finish dealing with 
the email right then, they will leave it in “In” as the safest place.

In order to evaluate the actions embedded in your email against all the other actions you need to take, you  
must be able to see reminders of those actions quickly and completely, along with all the rest. This is tough 
enough for the most organized, but almost impossible to do with more than a screen full of emails lying 
amorphously undefined in “In”. Here are some strategies for managing your Inbox and getting it to zero  
on a regular basis.

How to get email to zero 
The good news is that with the GTD methodology, you process email in the same way you do any other 
item in an Inbox. You need to delete a bunch, file some of them, do the quick ones, create a trusted 
system for deferring the ones that require longer-than-two-minute action and those that represent 
something you are waiting on that you delegated to others. 

If you’ve got any backlog of old, outdated emails sitting in the Inbox, we often suggest people clear out that 
first. Easier to stay on top of new email when your attention is not being bombarded with outdated emails 
from the past.

1.  Delete  Don’t be afraid to delete emails you no longer need. (<Ctrl> d works fast, too.) Your IT staff 
will love you for it, and it will shrink your Inbox a ton. If you have more than a few hundred backlog emails 
to deal with, try sorting by Date, From or Subject. You can often then delete, file or archive a bunch at one 
time. Obviously, keep in mind any data retention policies before deleting emails! Your IT staff would know 
current policies around that.

2.  Do  The two-minute rule in GTD is magic. With few exceptions, any email that can be responded to  
in less than two minutes should be handled the first time you see it. You should obviously delete whatever 
you can; but if you’re going to respond to it at all and it takes less than two minutes, it’ll take you longer 
than that to store it, open it up and read it again than it will be to handle it on the front end. 

File  Often reading and filing an email can be done in less than two minutes. Get comfortable with 
making reference folders in email for anything that would be useful to hold on to. Although relying  
on the search function can work, often having a folder titled very specific to the topic will be faster 
and easier to retrieve later. The shortcut <Ctrl+Shift> e makes a new folder fast.
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3.  Delegate  If someone else needs to take the action about an email, hand it off to them. Ideally, that 
should be done right away, unless it is going to take significantly longer than two minutes to hand it off.  
We recommend also that (if you have attention about the result from the handoff) you track it, and an 
easy way to do that is to cc: or bcc: yourself when you send a delegating email. That will give you a copy 
immediately back into your own Inbox, which you can then store in a Waiting For folder and track as  
@Waiting For in your Tasks. 

Create the @Action Support and @Waiting For Support folders email now. You can store them on the 
server or in your personal folders, whatever will work best for your Outlook setup and company guidelines 
around creating folders. Similar to the Action lists in Tasks, the @ symbol will force these two key folders  
to the top of your folders list. We will explain the use of these folders in more detail on the following pages.

 

A visual cue to remind you that there are emails stored in these two critical folders is to right-click  
on each of the folders and change the Properties for them both from “Show number of unread 
items” to “Show total number of items”.

Tip for tracking Waiting For items
Create a rule in Outlook to copy delegated items to an @Waiting For Support folder.

1. Select Rules button from the Home ribbon
2. Click Manage Rules & Alerts
3. Click on New Rule
4. Select Apply rule on messages I receive
5. Click Next
6. �Check off from people or public group. Then click on where people or public group is underlined 

and select yourself as the From contact (if you are not listed as a contact in your address book, you will 
need to create that first with the exact email address used by Outlook when you send email for this  
to work). Click OK. Click Next.

7. Check off move it to the specified folder. Then click on where specified folder is underlined and 
choose the Waiting For Support folder. Click OK. Click Next.
8. Check off except if my name is in the To or CC box
9. Name your rule
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Your final settings should look like this:

10. Click Finish

Try it out by sending a test message to an address other than the one you specified in the rule (such  
as another email account you use or a co-worker) and put yourself in the bcc: field. It should send  
a copy of the email to your Waiting For Support folder.

What this rule does is eliminate the step of having to dig through your Sent folder to find emails for which 
you are waiting on a response. Be sure also to track the Waiting For item on your Waiting For list in Tasks, 
unless you have the discipline to review this Waiting For Support email folder with the same rigor you 
would your Action lists.

4.  Defer  If you cannot Delete, Do or Delegate the email, your final choice becomes to Defer it to do later.
Where do you want to track that action? Do you want to have the email be the reminder or your Action lists  
in Tasks be the primary reminder? Either method can work very efficiently and elegantly. It will come down 
to your personal preference and discipline to work it consistently.  
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Two methods for organizing actionable emails:

Method One

Use your Action lists in Tasks as the primary reminder (our most common recommendation)
With this method, you have several choices of what to do with the email:

Option One: Drag and drop just the text of the email into a new Task and store the email in a folder.
Hold down your right-mouse button on the email and drag it down to the Tasks icon in the Shortcut Bar. 
Let go of your mouse when the Tasks bar is highlighted. Select Copy Here as Task with Text. Change 
the subject line to capture your next action, Categorize it, Save and Close. Then move the email in the 
appropriate email folder if you need that email again. Sending the email over as text only like this strips 
out all email formatting and related attachments. If there is no project, @Action Support or @Waiting For 
Support will work well for these kinds of random emails that don’t warrant their own folder, otherwise,  
park it in a topic or project folder.

Option Two: Manually create a new Task and store the email in a folder.
Move the email to the appropriate email folder. Open a new task (go to Tasks or use (<Ctrl+Shift> k)  
and capture your next action. Some people will make a note somewhere within the Task entry letting  
them know where the email is stored.

Option Three: Move the entire email over to a new Task as a file attachment.
You can also send the entire email out of email and over to Tasks, preserving all headers, file attachments 
and formatting. Hold down your right-mouse button on the email and drag it down to the Tasks bar. Let go 
of your mouse when the Tasks bar is highlighted. Select Move Here as Task with Attachment. Change 
the subject line to capture your next action, Categorize it, Save and Close. 
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To add an email to an existing entry, open the Calendar or Task item, click on the Insert menu in the 
ribbon, and select the Outlook Item icon. From the dialog box, select the email(s) to insert, choose Text 
Only or Attachment, and click OK. A copy of the email is attached and does not affect the original email.

By moving the entire email over to Tasks as a file attachment, when you decide to work on it you can 
simply launch the email from within the created task without having to find the email again in a folder.

If you ever want to move the email back to an email folder from Tasks, open the email from Tasks, select 
File > Move item to a different folder > Copy to Folder and select the location to copy the email into.

The advantage of moving emails to Tasks is that it puts all your next action reminders in one coordinated 
set of lists instead of spread into two different functional places in Outlook. The disadvantage is the small 
extra step it takes to get them over there. 

Method Two

Use the email as a central reminder and move it to an @Actions email folder
With this method, the @Actions email folder serves like a Task list. When you have an actionable email, 
simply hold down your left mouse button and drag and drop it to the @Actions folder. If you choose this 
method, capture your next action in the subject of the email so that you don’t have to process and rethink 
what you planned to do about that email. You’ll appreciate this when you revisit those action choices and 
don’t have to figure out what you were going to do all over again.

To edit an email subject line, open the email in a new window (this will not work from your inbox list  
or Reading Pane), and simply click on the subject line and start typing. You can still preserve the original 
subject line (if you need to), and delete your next action before replying back.
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Like Task lists, editing the subject line gives you a powerful quick snapshot of your next actions when  
you open the @Actions folder:

 

The advantage of method two is that it is the quickest way to organize emails. The disadvantage is that  
it adds an additional set of reminders of things to do to review against all your actions at hand. And, the  
“out of sight, out of mind” syndrome can be tricky for some—you must review contents of the @Action  
and @Waiting For folders as often as any of your other reminders to create a trusted system. We also see 
many people simply using this @Actions folder as storage for undecided actions. The purpose is not for 
simply moving emails out of the Inbox – it is for storing clear decisions you have made about Next Actions. 
Nothing would go into this folder until a Next Action has clearly been identified.

If you’re not sure if Method One or Method Two is better for you, try one consistently for at least a few 
weeks to see if it works for you. Both methods can support a seamless and trusted GTD system if you  
work the method consistently through daily inbox processing and regular Weekly Reviews.

Using Quick Steps
Quick Steps is a feature that assists you in quickly moving emails. We recommend this for filing into  
folders you use frequently, such as Action Support and Waiting For Support, as it will enable you to move  
the message in one click. We also recommend you create Quick Steps for moving emails into new Tasks,  
in addition to the drag and drop feature described earlier in this Guide. 

Quick Steps can be found in the ribbon under the Home tab. You will only see Quick Steps in email. You are  
given a default set which can be customized, and you can create custom Quick Steps to suit your needs.
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Click Create New and follow the simple prompts for each new Quick Step. For example, here are the 
settings for creating a Quick Step for moving emails into Tasks:

Delegating through Outlook
In our experience, Waiting For and Agenda lists and folders are by far the easiest ways to track your 
delegated items. Outlook does have the ability to delegate tasks to others, but in our experience, managing 
all of your delegated items through your own @Waiting For and @Agenda lists is a more seamless and 
efficient method. The primary challenge with using the “delegate task” function in Outlook is that the 
person you delegate the task to then owns the task and controls how that task appears in your lists.  
If they delete the delegated task, it deletes it in your lists as well. Also, many people feel uncomfortable 
“tasking” a boss or a peer through the delegation system and are much more inclined to send an email 
with the same request and discretely track it in their own system.

Option for categorizing emails
Outlook allows categorizing emails. While it seems like a simple feature, there are some key behaviors  
to be aware of with this feature. Categorized emails only appear in your email folders (not Tasks or To-Do 
bar) unless you flag the email for follow-up. If you are only using the email as the only reminder, this can 
work fine, but if you are also using Task lists you’ll want to stay current with both “lists”. Again, IMAP email 
users may not find the Categorize function works as expected or at all. This is a known issue with IMAP 
and Microsoft. 
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This refers to the Outlook Notes section, similar to the Task section in its ability to store and categorize 
information—not the Notes attached to the bottom of Tasks and Appointments. You can get to Notes  
by clicking on the shortcut for Notes in the bottom left Navigation Bar (or use the shortcut keys <Ctrl> 5). 
The Notes icon will not appear by default in your Navigation Bar, but that can be easily changed by clicking  
on the elipses (. . .) icon, Navigation Options, and changing the number of visible items to 5 if it is the  
5th item listed.

 

We suggest using the Notes section to create and effectively manage a limitless number of potentially 
useful (and fun!) non-actionable reference lists and checklists that you would not want to combine with 
your action lists in Tasks.

How it works as a list manager 
Notes can be categorized and viewed by category, similar to Tasks. Under the Home tab, select Notes List. 
Under the View tab, select Categories.

To create a note, click New or the shortcut <Ctrl+Shift> n. The top line of the note will automatically 
become the subject line or title of the note.  

To make the note larger, click and drag on the bottom right hand corner of the note, or double click  
on the blue title bar.
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To Categorize your note, click on the yellow icon in the top left corner of the note, select Categorize  
and choose the best category, or create under All Categories if it doesn’t already exist.

 

Click the X or type <Esc> to exit from the note, which automatically saves the entry. There is no Save 
button. Many people are surprised after they’ve setup all their categories and wonder why they do not 
appear. Identical to Tasks, the categories you create will only appear when you have a Note assigned  
to that category.

Note: IMAP email users may find that the Categorize button appears intermittently or behaves differently 
than the instructions describe throughout this Guide. This is a known issue with IMAP and Outlook. Please 
contact Microsoft Support or your IT department for further information on this.

Optional Sorting Trick – Since all Outlook categories appear in the same master category 
list, some users like to add a “z” to the beginning of Memo Pad categories (e.g., “zTravel”, 
“zChecklists”), so that those sort to the bottom of the categories listing. This can make  
for faster access to choosing the higher level categories used for Tasks. 
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Some great categories and lists 
This functionality is so totally open-ended and in one sense, so simple, the possibilities are infinite. 

Have you ever… 

•	 wondered whose birthdays were coming up soon? 

•	 had a wild idea you didn’t know what to do with? 

•	 wanted a place to capture and refer to the list of the speed keys you’ve been reading about in this document 
(which are in the back of this guide)?

•	 wanted to remember the great restaurant you ate at in London? 

•	 needed to remember all the things to check before you leave on a trip? 

•	 read something inspirational you wanted to keep and re-read every once in a while? 

•	 wondered where to put a suggestion about something to do the next time you visited a country? 

•	 needed to remember everything you need to handle when you put on a special kind of event? 

•	 wanted to keep track of all the articles or essays you might want to write? 

•	 wanted to have a list of clients and prospects to review occasionally? 

•	 wanted a place to keep track of the possible gifts to give special people in your life? 

•	 need a place to capture great team building and staff recognition ideas?

•	 needed a quick emergency contact list?

This kind of information can be easily managed in Outlook Notes, and will be particularly useful when  
it is synchronized to the Notes/Memo function on a handheld, so you have access to all that information, 
wherever and whenever. 

To get started, here are some possible categories and lists to play with: 

•	 Checklists 

•	 Clients 

•	 Areas of Focus 

•	 Fun

•	 Ideas

•	 Inspirations 

•	 Great quotes

•	 Lists 

•	 Might like to buy

•	 Might like to read

•	 Music to download

•	 Next time in… 

•	 Travel 

•	 Vacation ideas 
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For example, you could create a “Next time in Tokyo” category with information captured in separate  
Notes under that category or have all of the information in one Note categorized under the “Travel” 
category. There will be some trial and error here to find what works best for you, while maintaining 
simplicity and efficiency.

Capturing information on the go 
One of the great advantages of your digital world of information is how easily you can grab potentially 
useful bits of data from one place and park it in another. Using that in conjunction with Notes provides  
a tremendous productivity boost. Unfortunately you cannot add file attachments to Notes, but you can  
copy nearly any simple text or create web links.

For instance, you could go to our website, find David Allen’s personal “travel checklist” on our GTD Times 
blog, select the text, copy it (<Ctrl> c), create a new Note in Outlook (<Ctrl+Shift> n), paste it (<Ctrl> v), 
categorize the Note under Checklists and close to save it. 

Not that you necessarily want David’s checklist…! But anything like that–in emails, on the web, in an 
internal document you see—can be instantly accessible to you ubiquitously. We highly recommend that 
you copy our Weekly Review checklist from the Getting Things Done book, edit and add your own triggers, 
and insert it as a Note for ready reference. 

Watch for the opportunities!
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The Contact manager in Outlook provides straightforward functionality. Though there is nothing particularly 
mysterious about it, there are a couple of useful practices to be aware of. 

Get good at creating new entries 
Many people stack up business cards or save emails because they have some resistance to the labor 
required for entering data. If you can delegate the process, fine. But the people who always have the least 
problem with their contact manager are those who can enter data rapidly and easily into the system. 

<Ctrl+Shift> c creates a new Contact form, from anywhere in Outlook. The <Tab> key moves you from 
field to field. You can also Quickly add new entries from received emails by right clicking on the person’s 
name or email address in the From field and choosing Add to Outlook Contacts. 

Creative use of Search 
A simple yet very powerful procedure within Contacts is using the search bar to find keywords that you can 
embed in the notes attached to the people in your Contacts.

For instance, if you know that a client of yours loves opera, put the word “opera” in their notes. If you wind 
up with some good tickets to the opera, search for “opera” in your Contacts and instantly see the people  
you might consider inviting. 

If you develop the habit of inserting such keywords, you will have a very powerful but informal and  
easy-to-use relational database kind of functionality. Find people by hobbies, interests, business potential,  
or anything else you creatively decide to code in their record.
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We hope this instruction guide has been useful. It is intended as an adjunct to our core education  
of workflow mastery developed over many years—not a substitute. The most successful implementation  
of this guide builds on the understanding of the GTD best practices presented in our many learning tools, 
including the Getting Things Done book, our public and on-site seminars, individual coaching, and our 
online learning center GTD Connect®.

Please visit our website to take advantage of the many support tools and services available to assist  
you in getting your GTD system up and running. 

For more information, please visit:
gettingthingsdone.com
gtdconnect.com

Or contact us:
David Allen Company
407-F Bryant Circle
Ojai, CA 93023 

805-646-8432 
customerservice@davidco.com 
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Standard Windows Speed Key Combinations 

<Ctrl> a – Select the whole document 
<Ctrl> c – Copy whatever is selected to clipboard 
<Ctrl> x – Cut whatever is selected to the clipboard 
<Ctrl> v – Paste what’s in the clipboard to the cursor location 
<Ctrl> p – Print 
<Ctrl> z – Undo 
<Ctrl> y – Redo
<Alt> <Tab> – Switch between open Windows applications 

New Task Speed Keys

<Ctrl+Shift> k – opens a new task
Type the description in the Subject field
<Alt> h + g – opens category list (or use your 
custom category shortcut, if you created one)
<Arrow keys> – bring you to the desired category 
<Space bar> – selects the category
<Alt> s – saves the entry

Outlook Speed Keys 

<Ctrl+Shift> k – Creates a new task 
<Ctrl+Shift> a – Creates a new appointment
<Ctrl+Shift> n – Creates a new note 
<Ctrl+Shift> m – Creates a new email message 
<Ctrl+Shift> e – Creates a new email folder 
<Ctrl+Shift> v – Moves an email message
<Ctrl+Shift> h – Creates a new Office file 
<Ctrl+Shift> c – Creates a new contact 
<Ctrl> n – Creates new entry in current module
<Alt> h+g+a – Categorizes open task
<Ctrl> 1 – Switch to mail 
<Ctrl> 2 – Switch to calendar 
<Ctrl> 3 – Switch to contacts 
<Ctrl> 4 – Switch to tasks 
<Ctrl> 5 – Switch to notes 
<Ctrl> 6 – Switch to folder list 
<Ctrl> e – Go to the search box
<Ctrl> r – Reply to open message
<Alt> s – Send or save

New Calendar Speed Keys 

<Ctrl+Shift> a – opens a new appointment
Type the description in the Subject field
<Tab> – moves through the date and time 
fields until you reach All day event box
<Space bar> – puts a checkmark in All day 
event box
<Alt> s – saves the entry

7.  Conclusion

Speed Key Tips Sheet




